Notes for Schober Addresses ONLINE: Help and FAQs

Dear Client,
In this document you will find detailed information on how to use our application and on all the selection
criteria, as well as the most frequently asked questions and answers (FAQs).
Our Customer Advisory Service will be happy to answer any questions to which you cannot find an answer
here.
We look forward to dealing with you.
Kindest regards,
Your team at Schober Group
Hotline +41 (0)44 864 22 11
E-Mail info@schober.ch

Latest documentation update: November 2008
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Is this your first visit to our Website?
Here we have prepared a short introduction for you. This is how the "Schober Addresses ONLINE" shop
works.
First, choose the database.
On the Home Page you can choose from which databank you wish to put together your selection [see
Illustration, point 1]. We are constantly expanding our range of databases for your marketing promotions.
You can decide whether you wish to perform an address count without obligation as a guest, or you can log
in if you already have a customer account [2].
By the way, creating an account is absolutely without obligation and without charge and allows you to save
your selections. If you wish to register straight away, click in the right-hand column of the home page on the
"Registration/Log-in" button [3].
One click on the "Launch" button takes you to the page where you can put your selection together [4].

e
c

d
f
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Put your individual address count together.
After choosing the database, a page opens with the selection criteria. These are subsumed in groups. The
criterion which is displayed is always the main one – one click on the link "Search...“ opens the expanded
view with all related criteria[1]. Information on the criteria can be found via the question mark symbol [2].
Whatever is not relevant to your address selection you can simply leave out - you do not have to select some
thing from each category, eg: under "decision-makers“, a rational selection is preset. You can combine all the
characteristics as you wish. At the bottom of the page you can see what you have selected up to the
moment[3].

f
c
d
e

g

See how easy it is to find your way through the shop?
Here is some basic information on page layout: In the top navigation bar [4] you will find all those functions
which you do not always or immediately need. If you move the mouse pointer over them, the menu items are
displayed and can be selected. In most cases another dialogue appears where you have to make a choice or a
confirmation; so in doubt, just try out the items. The contents of "Current functions“ vary depending on which
page in the shop you are on at any one time.
This also applies to the tips appearing in the right-hand column which provide information on whatever page
you are on[5]. Below the tips are located the main buttons to control the application - in the case of criteria
selection that is the "Start count" button.
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Perform an address count as often as you wish.
You can take your time to find out your potential market : you can start an address count at any time without
obligation and without charge - it takes only a few seconds. You can modify it and repeat it as often as
desired; for this reason it is better to work "top down" - perform a count first of all with the most important
characteristics and then refine your selection.
After every address count the "Price information" is displayed. A click on the "Display selection details" link
shows a list of your selections so you can check them [1]. In the price information, you can see not only the
current number of addresses in your selection, but also the number of additional data items, such as
telephone numbers, decision-makers' names, etc. Depending on what you need, you can select which data
items you wish to receive [2].
Under "Current options“ [3] you will find other options, such as the possibility of saving or limiting your
selection, of seeing a preview of some data sets, or of printing the price quotation.
You can save your selection in the "Watch list" or place it in the "Shopping cart", and include it in your
purchase later. Of course you can go back to the selection criteria and modify your address count [4].

e
c
d
f
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This is how to save or to purchase your selection.
Address counts which you save in the watch list can be revised or purchased at any time. In order to save
your choices when you leave the current session, all you have to do is open an account.
Opening an account is of course free of charge and entirely without obligation. You will find "Registration"
under the menu item "My account“, then go to "Login“ [1]. Of course you can also register during the
purchasing process. When you register for the first time [2], after sending off your registration details, you
will receive an e-mail from us which contains a confirmation link which you must use just this once. This
ensures that only you have access to your account (Double Opt-In).

c

d
In order to purchase address data, simply move the current address count (or any of those in the watch list)
into the shopping cart. Then you will be led in 3 more steps through the purchasing process - just as you will
have seen in other online shops. After your purchase has been sent off, the data in the application will be
prepared and a link to your download (Excel file) displayed [3]. So you don't have to wait for delivery. Our
files are already prepared so that you can use them immediately, for example, for a mail merge.

e
Of course our expert Customer Advice Assistants are on hand to help you, to explain the various selection
possibilities, to check your selection before you download or to help with general questions.
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1. FAQs
1.1 Technical questions
1.1.1 Optimum configuration
Our application is best viewed using the following configuration:
Resolution: 1024 x 768
Browser: MS Internet Explorer 6.0 or higher, Mozilla Firefox
Browser configuration:
Text size medium or normal (Menu View >Text size)
Cookies should be accepted
Security level - intermediate (= standard configuration)
1.1.2 Problems with functions / cache
When using our application, you are not accessing a static website, but rather dynamically generated content.
For instance, when you request an address count or the contents of a watch list, your input is sent as a
request to our database and the results displayed in the application. This is why certain configurations of your
browser or Internet access may cause problems.
Error indication 1: After modifying an address count, the 'old' result is displayed, or modifications in the
selection criteria are not displayed.
Solution: This indicates that the page ha not been refreshed. The quick solution is to click on the "Refresh"
button, the page contents should be updated. You can also optimise your browser configuration: With MS
Internet Explorer go to Options > Internet options > 'General' > Temporary Internet files > Configuration...
In this dialogue, tick 'Every time I visit this page'. This does not seriously affect the security configuration.
Nevertheless, we advise you that we do not accept liability for configuration. If in doubt, ask your system
administrator whether this configuration is advisable.
Error indication 2: When moving from one page to another a warning is displayed that you are moving
between secure and insecure pages.
Solution: This is due to the fact that some areas of the shop are encrypted for security reasons and others
not. If the warning bothers you, you can deactivate it in MS Internet Explorer by going to Tools > Options >
Internet options > Advanced and under the Security section uncheck the box which says 'Warn when
moving from secure to insecure mode', then the warning will not be constantly displayed.
Error indication 3: The search according to sectors or localities is not performed; an address count is
requested but the results not displayed; when calling an address count from the watch list, you are logged
out.
Solution: Please ask your system administrator to check the configuration for accessing the
'shop.schober.com' page and to change them. Problems can arise due to the configuration of the firewall,
router or the proxy-server or the use of constantly changing IP addresses - we cannot see these
configurations and so cannot provide a global answer. Usually, small, quick modifications, for instance,
entering our page as a recognised secure site are sufficient to use all the features of our application.
Of course we are available to answer your questions.
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1.2 Address count
1.2.1 When can I start an address count?
Immediately. At any time and without registering, you can put your desired selection together and perform an
address count. Within a few seconds, the result (numbers of addresses and prices) will be displayed. With
more complex selections or which require accessing the database frequently, this may take several minutes.
1.2.2 Where can I see the prices?
Schober uniquely offers you a wide variety of ways to select addresses. This way you can set up your target
group precisely according to your needs. The prices of the addresses selected are determined by the desired
purchase quantity and the additional information you request.
The advantage to you: At Schober Addresses ONLINE you receive, within seconds of starting the address
count of your potential target group, a non-binding price quotation with the exact number and prices of your
selected addresses.
1.2.3 And if I can't find the sector I'm looking for...?
When you use the keyword search, our application looks for similar terms to your input anyway - but if you
still cannot find a particular term, then try a synonym, eg: hardware store instead of ironmongers, because
occupational and sector denominations are sometimes different depending on region.
It is better to enter abbreviated terms, or parts of the term, in the search box and please do not use special
signs (hyphens, etc.).
An alternative is to use the tree structure. Here you can click your way through the topics (sub-sectors) until
you reach the sector you are looking for. Further information can be found under Section 2.1.1. (searching
sectors).
1.2.4 I have questions on the selection criteria...
Quick information is available in the application, if you click on the question mark near the selection criteria.
Comprehensive information on the individual selection criteria can be found here in Sections 2 (for company
addresses) and 3 (for private addresses).
1.2.5 No count result is displayed...
In the event that on the basis of your selection criteria you receive no search results, immediately after the
address count you will receive a note advising you to extend your selection somewhat.
If an address count takes longer than 5 minutes, please ring our Hotline. as there might be a technical fault.
As a rule, it only tales a few seconds, if the database is overloaded possibly 1 or 2 minutes, to produce your
individual result.
1.2.6 How can I check my selection before downloading?
After performing an address count, in the price information via the menu item 'Current options » Preview',
you are able to view some data sets in order to check whether your target group selection has been made
correctly. For Data Protection reasons, this function is only available for company addresses.
We will be happy to perform a selection check free of charge - our experienced address specialists can
guarantee that you have made exactly the right choice. If you have any questions on the matter, call or send
an e-mail to our Customer Advice Assistants.
© Schober Group, 2008
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1.2.7 Where can I find the address counts I have saved?
As a registered user, you will find your address counts in your personal area under 'My account » My watch
list'.
For this, however, your selection must have been saved in the watch list. Address counts which are not added
to the watch list expire at the end of the session, in other words when you leave our website.
Via the watch list, you can see at any time the status of the selection you have stored, you can inspect the
price information and modify or purchase an address count.
In the case of older address counts, when you open your account you are asked to perform the address
count again; this is to ensure that after each update of the databases (weekly) you receive the current
number corresponding to your address count.
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1.3 Registration
1.3.1 Do I have to register?
No. Within our application you can perform as many address counts as you wish free of charge.
However, your address count cannot be stored. You can conveniently save your address counts in a
temporary watch list - but this is only valid for the current session, in other words as long as you do not close
the browser window. If you make a non-binding registration, your address counts will be saved permanently.
1.3.2 When and how do I receive the "activation code"?
Immediately after registration you will receive, for security reasons, an e-mail with an activation code. This
ensures that only you can activate your account (Double Opt-In).
The e-mail includes a link - one click on it is enough. A page opens where you see confirmation that your
account has been activated to receive addresses. This procedure is necessary only once; on future visits you
can simply log in and purchase addresses immediately.
1.3.3 The link to the activation code doesn't work...
After clicking on the link to the activation code, if you receive a message that your account could not be
activated for technical reasons, there are two possibilities:
a) it may be that the link was modified as it was sent to your e-mail program. Copy the link from the e-mail
directly into the address line of a new browser window and press "Enter".
b) if that does not work either, get in touch with our Customer Advisory Service; during our usual business
hours we will be happy to help you and activate your account straight away.
1.3.4 My login/password is not accepted...
Please enter the login and password which you chose when you registered. You can request a new password
on the 'Log-in' page if you have forgotten it. Please note that for security reasons, a new password will be
generated by computer - after you have successfully logged in, you can change it for a password you choose
yourself.
If this does not work, mail us and we will help you.
1.3.5 Where can I change my address details?
If your address or e-mail address change, you can change these details as a registered customer under 'My
account » My account-data'.
Changes affecting your invoice address are put into our database only after checking by our Customer
Advisory Service and so are only visible thereafter. You do not need to enter them several times.
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1.4 Purchasing
1.4.1 How long is the service free of charge?
Only after you have placed your choices in the shopping cart and have been through the various steps of the
purchasing process is a download started and an invoice made out.
It is not possible to set in motion by accident a process which ends in you having to pay; there are no hidden
costs beyond the final invoice value shown in the price information.
All address counts and the administration of your account are of course completely without obligation and
without charge.
1.4.2 How do I redeem a voucher ?
Vouchers or promotional codes can be redeemed during the purchasing process in the shopping cart. For this
purpose under the price summary there is a box to enter the code, and after that click on the "Update“
button, the shopping cart displays the deduction.
You still have the choice of using the voucher later. To do this, simply empty the shopping cart and fill it
again.
1.4.3 What payment methods can I use?
You can pay conveniently by invoice or by credit card.
Paying by credit card: you can pay with VISA, MasterCard or American Express. Your details are sent via a
secure connection and are not stored. As a rule, the invoice value will be charged to your credit card account
a few days after the purchase. The address file will be made available for download without delay
Paying by invoice: pay with the convenience of an invoice. The address file will be made available for
download immediately. If you are a new customer, the addresses will be made available to you after release
by our Customer Support Service. You can finish your purchase in the shop as normal - our Customer Support
Service will check the purchase as quickly as possible, at the most within one working day. After that, you will
receive an e-mail which leads directly to the download of your file.
Independently of the means of payment, the invoice will be sent to you by e-mail the day after your purchase
so you can print it for your accounting records.
1.4.4 Can I include a different invoice address?
Invoices are always made out to the address which you give during registration.
If you wish to change your address, you can change these details under 'My account » My account-data'.
Please understand that these changes of address will be activated after being checked by our Customer
Support Service.
1.4.5 How does the download work?
After you have placed your address counts in the shopping cart and have completed the remaining steps,
immediately after you send off your purchase, the addresses will be compiled. Depending on the number of
addresses, this may take some minutes. The progress of the compilation can be followed on the purchase
completion page, so meanwhile, please do not leave this page.
Then a link will be provided for each selection purchased, a click on the link will open a dialogue window in
your browser where you can choose the destination for the file. After that you download a zip-file which
contains the data you have purchased as an Excel file.
© Schober Group, 2008
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We retain the data for you for a while - for 30 days via 'My account » My order history' (visible only when you
are logged in), you can download it again.
1.4.6 The file has not been completely transferred.
If the data you downloaded is not readable or the download was interrupted for technical reasons, this is no
problem.
The file can be downloaded again any time during 30 days via 'My account » My order history' (visible only
when you are logged in) without charge.
Or you can contact our Customer Support Service, who will make the data available.
1.4.7 After downloading, I discovered a mistake in the selection.
In the event that you have not selected the correct data - no problem: just give us an email, we will define a
replacement selection. As a rule, this can be done within a few minutes. After all, our aim is to provide you
with optimum data for a successful campaign.
1.4.8 What format do I get the addresses in?
We deliver in Excel format; in the case of 65 000 data sets and above, as a csv file. First of all you download
a zip file which contains the Excel file - a double-click on the file name in the zip window opens the address
list.
The fields contained in the file (scope of information) you will find in the information on firms' or private
addresses (Sections 2 and 3).
1.4.9 Where can I find information on my order history?
On the one hand, immediately after sending off your purchase, you receive an e-mail as purchase
confirmation.
A complete summary of your purchases to date can be found in your personal area under ''My account » My
order history'. To do this, you must be logged-in.
Using this purchase history, from the day after the purchase, you can inspect the detailed invoice (which will
be sent to you the day after by e-mail), or for 30 days after your purchase, download the data once again in
case the first transfer did not work.
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1.5 Use of the address data
1.5.1 How often can I use the addresses I have downloaded?
The address data you have licensed may be used for one year (from the download date) for your sales and
marketing activities as often as you wish.
So you have an entire year to convince your potential customers. As often as you wish and by different
methods - depending on which contact details you have licensed apart from the postal address (please note
the following Section).
All those prospects who react to your direct marketing promotions, whether firms or private individuals, who
enter into business with you, request price quotations, etc., of course are not subject to limits on their use in
future.
Data may not be sold on or transferred for their use by third parties. Further information can be found in our
General Terms and Conditions of Business in the shop website.
1.5.2 May I use telephone numbers or e-mail addresses?
These details are only available for company addresses. These contact details have been gathered from
publicly available sources - as a result no agreement exists on the part of firms that they accept being
contacted by you.
For this reason we must particularly refer you to the legal provisions of each Federal State regarding the use
of fax and e-mail addresses - in Germany this is regulated by Paragraph 7 of the Law on Unfair Competition
(UWG). We do not recommend campaigns using telephone-/fax-numbers or e-mail without the previous
agreement of the recipient. This data is better put to use after successfully making contact by post .
We provide the number of the main telephone number (switchboard number), in other words no extension
numbers or personal e-mail addresses. Please note that for contact details with a higher rate of fluctuation
fewer sources are available than for postal details, and thus may not be so up-to-date. For telephone and
fax numbers, please assume 80% will reach their destination and 70% for e-mail addresses.
1.5.3 How up-to-date are the addresses?
At Schober Addresses ONLINE we update the complete database on company addresses every week and on
households every month. In the process, many thousands of information items are updated, new addresses
included in the database and out-of-date items removed.
For instance, every year more than 600 000 company start-ups are recorded, roughly the same number of
inactive firms deleted and well over 10 million decision-makers' names, Internet addresses, company sizes,
sectors. etc. updated.
To do all this, the Schober Group goes to enormous trouble, with numerous data centres of its own and the
most modern IT methods. Several million Euros each year are put into the recording and updating of
databases, so that at any time you receive the very best data possible for your direct marketing promotions.
The average postal deliverability is around a market-leading 95% (in comparison with other databases which
cover the whole market). In view of the size of our databases it is clear that different results may occur. All
data are gathered from surveys and public directories - we can provide more information on large companies
from many sources than on small firms.
Since we always include the details provided by companies themselves, a sector may differ somewhat from
the main activities of the company. Or, for instance in the case of the self-employed - an address may look
like a private address but is in fact the original address of the firm.
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And yes: when it comes to the names and positions of decision-makers, or contact details, eg: telephone
numbers, our statistics are 'only' about 85% accurate, due to the fact that changes of decision-makers, as a
rule, are only published by large companies. In Germany for example, every year more than 20% of
telephone numbers are changed - in the case of firms. In the case of private households the number of
moves or changes in the household is considerably higher.
In particular when it comes to involved data maintenance such as telephone surveys of medium and large
companies or the evaluation of composition of households on site, only the Schober Group does this - no-one
else provides this service. However, it may be that the up-date of an individual profile was undertaken some
time in the past, simply because of the sheer mass of data.
But you can be sure: as the market leader in German-speaking areas we feel obliged to provide the most
comprehensive databases with the best addresses to ensure your personal success.
1.5.4 Circular letters
You receive our addresses as an Excel file with a professional record layout. This way you can import the
addresses without further ado into other programs or use them in a mail-merge - even the address line
('Sehr geehrte Frau Dr. Mustermann - or whatever) is already prepared.
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2.1 Sectors
2.1.1 Methods for searching sectors
If you do not wish to limit economic sectors, but rather select all firms and institutions by other
characteristics, then simply choose nothing here. Even without selecting a sector, the main business of an
enterprise is always provided.
The search on sectors is performed according to the EBC (European Business Code). With over 6 500 target
groups, it represents the most detailed sector system on the market, and is thus ideal for marketing purposes.
There are 2 search possibilities:
Using the keyword search, you enter a search string and you will be given a list of suggestions which
displays similar sectors. The most relevant search results are given first. If there are more suggestions, you
can call them up via the link „more search results...“.
The term which appears in brackets after some sectors is what is called the synonym by which the sector was
found. By using the search for related terms you get more suggestions, although of course these may not be
specific enough or be too general.
In the event that you receive no suitable search results, try using parts of terms, eg: 'engine' instead of
'engineering' Please do not enter several terms or hyphens.
Using the search via the tree structure you get a more comprehensive view of the markets sorted by topic.
Using the plus sign you can expand the branches in the tree and see the sector details.
In order to select a sector for an address count, tick the check box next to the sector description. These will
then be searched for in the sequence of your selection in a non-overlapping manner.
You can see your choice of sectors up to the moment at the bottom of the page. There you can remove
sectors again.
You can repeat searches and keep the results in your selection as often as you wish. You can choose up to 40
sectors and keep them in your selection.

Tip: Instead of using lots of detailed sectors, it is better to use a few higher ranking ones in order to achieve
a more complete coverage of your target group.
2.1.2 Excluding sectors
You can also define economic sectors you want to exclude from your selection . All those addresses which
are listed in sectors which you exclude will not be taken account of in the address count.
This may lead to companies being left out because, besides the sector you wish to target, they also work in
a sector which you wish to exclude. For example: You would like to select petrol stations without a shop. If
you now actively choose "petrol stations", but use "retail trade" to exclude a complete sector, then you will
get no addresses because petrol stations are also "petroleum retail traders". In this case, you should only
exclude the foodstuffs retail trade. So for exclusions it is better not to use overall sector descriptions, but
rather to filter as finely as possible.
2.1.3 Non-overlapping selection
Within each address count, the sectors are counted in a deduplicated manner, that means that if a company
is listed in more than one of the selected sectors, because of the non-overlapping selection, it will still be
included only once. In the data set which you download, you will be given the sector in which the company
was first found.
© Schober Group, 2008
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This is why it is important to set detailed sectors always before general (higher-ranking) sectors. For example:
first of all you have divided up architects according to their specialities and you want to select the remaining
addresses from the total of all architects. As a result, in the list after the address count you see the numbers
in the detailed groups and the remaining number of architects who have not been allocated to one of the
detailed groups.
If you have already selected a higher-ranking sector before the detailed groups, then delete it again (see
below in the summary of all criteria) and then select it again - in this case it will be placed after the other
sectors. The address count takes the sectors in the sequence you have chosen them.
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2.2 Characteristics
In the case of these criteria, limit the characteristics as much as possible because they are in any case linked
by a logical "AND": The more of them you tick, the more you filter your selection. It is better to start an
address count with few characteristics and then narrow your choice a little more at every step.
As we acquire data from different European databases, not all characteristics are identical in all countries.
2.2.1 Size of company
This characteristic can be applied to 100% of our company addresses and is thus the best criterion, as it is
the most complete.
The basis for company classification is a mathematical scoring process, which is founded on all existing
information, such as number of employees, turnover, number of executives, legal form of the company, etc.
The distinguishing features are one approach and correspond roughly to the following classification by
workforce:
large companies = more than approx. 100 employees
medium-sized companies = approx. 6-100 employees
small companies = up to approx. 6 employees, and one-man firms
Please note: If you select this characteristic, you should not limit the number of employees as well, since the
characteristics overlap considerably.
2.2.2 Number of employees
Since we generate information from company publications and our own surveys, we still do not have details
on the employees in every company. With large companies of course there is more information on hand than
for smaller ones (the key here is the obligation to make information public).
So, particularly if you wish to target smaller companies, use the 'Size of company' characteristic, which is
much more complete.
2.2.3 Company headquarters
We record company addresses without regard for the legal status of the company. This means that in our
databases we also have branch offices, subsidiaries, production facilities, etc., which are not legally
independent and may only take limited decisions.
You have the possibility of selecting only head offices - but note that in that case individual enterprises that
are neither head offices nor branches are not selected.
It is also possible to limit the search 'Without branches': In this case, addresses with this information are
excluded. This selection does not claim to be complete, since the information item regarding a 'branch' is not
always present.
2.2.4 Legal form of company
The legal form of a company is always available for all companies recorded in the Register of Companies or
other official institutions. In sectors which are generally composed of one-man firms or small businesses, this
characteristic acts as a strong filter.
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2.2.5 Founding date
The founding date is taken from the Register of Companies or other official sources. This means the
information regarding (small) businesses which are not obliged to register is limited in scope.
This characteristic is useful to find those start-ups which require a lot of equipment or services early on.
2.2.6 Contact details
You can limit your selection to addresses which have a telephone number, eg: if you are planning a purely
telephone marketing promotion.
Whether you purchase the contact details at the same time you can decide after the address count (at the
price quotation stage). After each address count, the available number of telephone numbers will
automatically be displayed.
For company addresses, you can add the telephone numbers and optionally a package which includes fax, email, and Internet address. Or you can choose straight away the "company profile" which include these and
a great deal more data.
There are a few things you should know about the contact details:
Telephone numbers are available in about 90% of cases, fax numbers in about 30%, e-mail/Internet
addresses in about 20% of cases These are average figures; for small firms there is less information available,
for larger ones, more. Please note that for contact details with a higher fluctuation rate fewer sources are
available than for postal details, and thus may not be so up-to-date. Please assume a deliverability of
approx. 80%. We provide the central telephone number (switchboard), in other words no extension numbers
or personal e-mail addresses.
Important note: Please note that we do not have the agreement of the companies listed for you to contact
them. For this reason, we refer you to current jurisprudence regarding the use of e-mail addresses and fax
numbers.
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2.3 Region
If you do not wish to limit the search by region, then do not check any of the boxes. It is not necessary to tick
all the Federal States or Cantons.
Important note: Regional characteristics (contrary to other selection criteria!) are linked with a logical "OR";
so you can, for instance, search for post codes and localities from different regions at the same time. For the
mathematicians among us: In the case of selection by region, it is not the subsets but rather the union of sets
which are considered.
So please note: If you wish to choose only certain localities, do not click as well on the Federal State (or the
Canton), otherwise because of the "OR" link, the entire Federal State (Canton) will be selected.
2.3.1 Post codes
Post codes can be combined as you wish. Please separate the individual post codes by commas and postal
districts by hyphens, eg: 70499,71,72,8,40000-41653. Please do not use placeholders (asterisks or similar) the application interprets your input automatically and reads an input of '80' (for example) as the entire 80
postal district.
2.3.2 Search within a radius
There is also available a search in a radius around a single 5-figure post code In this function, a radius is
drawn around the required post code and all the post codes touched on by this radius are included in the
address count. Please note that the distances are measured in a straight line, actual route distances will
almost always be longer.
2.3.3 Place names
When searching for localities or administrative units: Local Authority Areas (in Germany: Regierungsbezirke
und Kreise, in Austria: pol. Bezirke) the keyword search is there to help you. After performing the search,
simply mark the desired entries by ticking the check box. If you make a new keyword search, it may occur
that you cannot see your choice of localities up to the moment. However, you can see a summary of your
choice at any time at the bottom of the page. There you can remove once again regions you have chosen.
2.3.4 Federal States/Cantons
If you select a Federal State (or Cantons in Switzerland) the entire Federal State will be taken into account.
So, only use this characteristic if you really want to target the complete region. As mentioned above, it is not
necessary to choose as well the Federal State in the case of locality names which occur more than once.
2.3.5 Linguistic area
In Switzerland, as an exception, there are 3 linguistic areas to choose from. This allows you to reach your
target group in the appropriate language.
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2.4 Decision-makers
Decisions are made not by companies, but by people in those companies.
This is a reason to personalise your addresses. However, you can leave this point out, we have already preset
a suitable personailsation.
Whether you also purchase the decision-makers' details can be decided at your leisure later - the available
number is always displayed exactly after an address count). You receive not only the form of address,
academic title, first and surnames, but also the job position and a pre-configured personal address line for a
letter.
2.4.1 Job function
You can also refine your personalisation by choosing the appropriate decision-makers' job area for your
product or service from 8 function groups. In these groups we have condensed all the activities of decisionmakers which belong to this area. When you purchase decision-makers, in the data you will see the detailled
job description (eg. "Education and Training Manager") of the individual in question.
2.4.2 Single/multiple targetting
Mostly targetting one person in the company is sufficient. In larger companies, perhaps it might be better to
target several decision-makers. To do this, enter the desired figure in "Maximum number of decision-makers".
Please note that as a result you will receive the same company address with more frequency - if you choose
3, you may receive up to 3 address items which are identical except for the details of the decision-maker.
If at the same time you have selected several job areas, the application attempts to provide as broad a choice
of decision-makers as possible. For example, if you have selected "Marketing“ and "Management" and
chosen 'maximum.. 2 people per firm', first the application will look for the Marketing Manager and then for
the Managing Director. If there are no decision-makers in the area of marketing, then the application might
select 2 contacts from the management.
Since there is not always a current decision-maker available for every address, a suitable departmental
designation (additional line) will be provided to ensure that you reach "the right desk". This text will be
automatically provided if the decision-maker is not known or not selected. Afterwards you can of course
change it in the Excel file that you receive.
2.4.3 Complete personalisation
You can of course choose only personalised addresses. This configuration is less recommendable as you will
forego all those companies in your target group for which we do not have (or do not have at present) a
decision-maker's name. This filters out very many results in the categories of small firms and freelancers. In
the case of one-man firms, as a rule, there are no names available, since there are no named executives
apart from the proprietor.
Another thing: if you really want no data on contact persons, you do not need to alter anything in the
selection; whether you want to purchase decision-makers' details is something you decide only after receiving
the price information for the address count.
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2.5 Current options
2.5.1 Partial selection
In the event that you do not wish to use the same criteria for all sectors of a selection (region, company size,
etc.), you can put together different selection groups with different characteristics.
Selection groups are individual partial requests within an overall selection. All the same, all addresses are
non-overlapping, in other words, they will not be counted twice. In the download file, each selection group is
assigned a number so that if need be the individual groups can be separated (eg: using a filter in MS Excel).
So for instance you could retrieve banks and insurance companies with the criterion 'Head offices' for the
whole country, and in the same address count (in a second selection group = partial selection) retrieve
insurance agencies with more than 5 employees from a particular region. This way you achieve a quite
individual selection of your target groups.
You can call up 'Partial selection' via the menu item 'Current options » Selection groups'. A new dialogue
appears which gives you the possibility of adding additional selection groups (in which case no criteria are
already set for the group) or to copy an existing group with all its criteria, in order to modify them.
And you can of course delete these selection groups again. To do this, you must have activated the group you
want to delete, then call up the dialogue and use the "delete" menu item.
The selection group where you are at any one time is indicated (highlighted) by the tabs which are displayed
as soon as you put together a new group. The overview of all the criteria selected (at the bottom of the page)
refers only to the group which is currently active or marked.
If you are working with few target groups or do not need different characteristics, naturally only one selection
group is sufficient.
2.5.2 Limits
You can define a limit, ie: a maximum number of addresses. In this case, a random selection is made from
the overall number.
You can call up this function after an address count (in the price information) via the menu item 'Current
options » Limit number of addresses' .
2.5.3 Excluding previous selections
Each download you make is marked for you permanently and free of charge in our database. This way you
can exclude addresses you have already purchased from subsequent counts to avoid repetitions.
As a registered user, you can have all your previous downloads listed, (if you have made any) via the menu
item 'Current options » Exclude previous orders' and click on all those you wish to exclude. Note: If you have
only just performed the download, it may take several minutes until it appears in the list.
This function can be called up after an address count (in the price information). So, first perform the address
count of your potential market and then narrow it down.
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2.6 Price information/ price quotation
Immediately after the address count, clearly laid out price information is displayed. You are able to see all the
selection details, and all the numbers of companies, decision-makers, as well as additional data.
Here we are not talking about approximate figures but about precise numbers - what you see in the price
information will be exactly what you receive in the purchase.
You can then place your address count in the shopping cart and purchase immediately - within minutes you
will have the data on your hard disk. Or you can save it in the watch list in order to return to it later. (Note:
the watch list can only be saved from one session to the next if you are registered).
2.6.1 Preview
After performing an address count, in the price information via the menu item 'Current options' » 'Preview of
addresses', you are able to inspect some random data sets in order to check whether your target group
selection has been made correctly.
The addresses here are shortened. If you make a download, you will of course receive complete data sets,
including any other fields you have selected.
2.6.2 Scope of delivery
You can chose between two different supply formats:
Company profiles [1] always cover all the available data which is valuable for your marketing decisions.
Target group addresses [2] cover at an advantageous price all the data which is specially relevant for
mailing or telephone marketing promotions. Optionally, you can purchase further information; the extra prices
for these details are explained in the price quotation.
The exact contents of the data files can be found on the next page.
In both cases, the same record layout is supplied (Excel file), so that independently of the supply format you
can always use the same import routine for your usual computer programs.
All additional details such as fax number, e-mail/Internet address, number of employees, turnover category,
etc. are supplied if they are available. The extent to which the characteristics are complete depends on the
size of the firm. A completed personal address line is always included ("Sehr geehrte Frau Dr. Müller").
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Field name
Order-No.
Position
Adress-ID
Salutation
Company name1
Company name2
Company name3
Street and Houseno.
Post code
City
Postbox
Post code (postbox)
City (postbox)
Community key
State
Country
Country prefix
Prefix phone
Phone number
Prefix fax
Fax number
Email
WWW
Company size
Number of employees
Legal form
Headqu./branch
Turnover
Founding year
Salutation named
contact
Title named contact
First name
Last name
Function
Letter salutation
Additional line
Sector

Contents/explanation

Switchboard or central fax number
General company email-address
Company website
Very large / large / medium-sized or small company
Number of employees at location
Legal form of society, partnership
Identifier central or branch office
Turnover category (per annum in Euros)
Year founded
Form of address (Mr. /Ms.) decision-maker

[1]
9
9
9
9
9
9
9
9
9
9
9
9
9
9
9
9
9
9
9
9
9
9
9
9
9
9
9
9
9
9

if appropriate title of decision-maker
Decision-maker's first name
Decision-maker's surname
Description of position / activity in company
prepared personal address line for letters
Additional line for non-personalised addresses
Description of selected sector or firm's main activity

9
9
9
9
9
9
9

ID for partial selections
Unique address-ID
Form of address (Mr./Ms.) for one-man firms

ID for locality, region, Federal State; not available in CH
Federal States in GR/AT, Canton Identifier in CH
Country identifier

Switchboard number

[1] Company profiles
[2] Target group addresses with optional package
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[2]
9
9
9
9
9
9
9
9
9
9
9
9
9
x
x
x

Optional
Optional
Optional
Optional
Optional
Optional
Optional
Optional
Optional
x
x

Optional
x

Optional
Optional
Optional
Optional
Optional
Optional
Optional
9
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3. Search using the private addresses database
Please note, that the criteria for the private addresses databases or Germany, Austria and Switzerland have
more differences than the company addresses. Therefor you will see the flag symbols – which shows you,
which criteria is available for which country.

3.1 Socio-economics
3.1.1 Gender
Here you can choose whether you wish to address only men or only women. In households with two or more
persons, in the address the name of the first named person is given. If you select 'All', the first named
person in the household will be provided independent of gender.
3.1.2 Age group
Age classification is carried out as far as possible on real data. A person's real age may not be exact in some
cases.
3.1.3 Household size

/Civil status

The choice "Single person households" does not automatically mean that the person lives alone - rather that
only one person in the household is known. In households with two or more persons, in the address the name
of the first named person is given. Other forms of household, such as flat-sharing cannot be individually
selected.
3.1.4 Age of children
If you want to select families, you are able to define, in which age one or more of the childs shall be.
3.1.5 Lifecycle
Here you can choose, in which life situation your target group is. It is not only defined by age but several
merged informations upon the household.
3.1.6 Job position and graduation
With this criteria you can select high-graduates or persons in certain job situations.

3.1.5 Telephone numbers
Please note in your own interest that the usage of telephone numbers are strictly regulated by law in
Germany and Austria. The supplied telephone numbers are given exclusively for the purposes of comparison
and updating. You can use them to update your database. Their use in the context of telephone surveys for
the purpose of market and social research is permitted for such institutions. Calls for advertising purposes
without previous consent (telephone opt-in) are not permitted! When using this data please observe the
current regulations of Laws on Unfair Competition as well as current jurisprudence.
In Switzerland you can select numbers without a so called “Sterneintrag”, which means, that those persons
are willing in to contacts by phone.
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3.2 Residential characteristics
3.2.1 Type of dwelling
Here you can choose the kind of house in which the households in your target group live. In the case of
apartment buildings, all households in the building are listed, unless you define other criteria.
3.2.2 House size
This information tells you, how many households are in the builing. In the case of apartment buildings, all
households in the building are listed, unless you define other criteria.
3.2.3 Construction date category
Taken in combination with the type of dwelling and/or situation of the house in the locality, the construction
date allows conclusions to be drawn on the inhabitants' lifestyle.
Inhabitants of classic older buildings in the town centre have different needs to those of the owners of new
detached houses in smaller localities.
3.2.4 Construction type
Construction type often allows conclusions about the purchasing power of the household living there. Living
conditions express style of life (more simple, more ostentatious...) which can be extended to the general
purchasing behaviour.
3.2.5 Garden
Here you can choose whether your target group lives in buildings with their own garden (in the case of
apartment buildings, with a common space) .
3.2.6 Situation of the dwelling in the locality
In particular in larger towns the needs of households in the city centre may be considerably different from
those on the outskirts.
3.2.7 Size of locality
Using the "Number of inhabitants" characteristic you can target the needs, or purchase or mobility behaviour
which are often different between town and country.
The number of inhabitants recorded by the Federal Statistical Office applies to suburbs which have been
incorporated into a municipality.
As an alternative or extension, you can also define country/suburban areas via the region (select using Kreise
[Local Authority Areas]).
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3.3 Region
If you do not wish to limit the search by region, then do not check any of the boxes. It is not necessary to tick
all the Federal States or Cantons.
Important note: Regional characteristics (contrary to other selection criteria!) are linked with a logical "OR";
so you can, for instance, search for post codes and localities from different regions at the same time. For the
mathematicians among us: In the case of selection by region, it is not the subsets but rather the union of sets
which are considered.
So please note: If you wish to choose only certain localities, do not click as well on the Federal State (or the
Canton), otherwise because of the "OR" link, the entire Federal State (Canton) will be selected.
3.3.1 Post codes
Post codes can be combined as you wish. Please separate the individual post codes by commas and postal
districts by hyphens, eg: 70499,71,72,8,40000-41653. Please do not use placeholders (asterisks or similar) the application interprets your input automatically and reads an input of '80' (for example) as the entire 80
postal district.
3.3.2 Search within a radius
There is also available a search in a radius around a single 5-figure post code In this function, a radius is
drawn around the required post code and all the post codes touched on by this radius are included in the
address count. Please note that the distances are measured in a straight line, actual route distances will
almost always be longer.
3.3.3 Place names
When searching for localities or administrative units: Local Authority Areas (in Germany: Regierungsbezirke
und Kreise, in Austria: pol. Bezirke) the keyword search is there to help you. After performing the search,
simply mark the desired entries by ticking the check box. If you make a new keyword search, it may occur
that you cannot see your choice of localities up to the moment. However, you can see a summary of your
choice at any time at the bottom of the page. There you can remove once again regions you have chosen.
3.3.4 Federal States/Cantons
If you select a Federal State (or Cantons in Switzerland) the entire Federal State will be taken into account.
So, only use this characteristic if you really want to target the complete region. As mentioned above, it is not
necessary to choose as well the Federal State in the case of locality names which occur more than once.
3.3.5 Linguistic area
In Switzerland, there are 3 linguistic areas to choose from. This allows you to reach your target group in the
appropriate language.
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3.4 Interests
3.4.1 Postal purchase behaviour
Households with this characteristic are more open to written offers and purchase more often by post or
online. You should only use this characteristic if you wish to encourage a written reaction or order. In the
case of other promotions, eg: invitations to your shop or to fairs, this characteristic is not required.
3.4.2 Interest and consumption focus
Households which buy certain products more frequently show interest in certain product groups and topics.
You can of course choose several areas of interest, the characteristics are linked by a logical OR.
Nevertheless, a household which has several interests will only be given once.
In a household with various members, no distinction can be made between the interests of the individual
members.
3.4.3 Purchasing power forecast
This characteristic is calculated by means of a mathematical-statistical process. This involves not genuine data
on the households, but rather probabilities, which however have been shown statistically to be quite accurate.
3.4.4 Donation affinity
This characteristic is also calculated by means of a mathematical-statistical process.
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3.5 Current options
3.5.1 Partial selection
In the event that you do not wish to use the same criteria for all addresses of a selection (region, composition
of household, interests, etc.), you can put together different selection groups with different characteristics.
Selection groups are individual partial requests within an overall selection. All the same, all addresses are
non-overlapping, in other words, they will not be counted twice. In the download file, each selection group is
assigned a number so that if need be the individual groups can be separated (eg: using a filter in MS Excel).
So for instance you could retrieve inhabitants of detached houses with garden, interested in fashion and
luxury items and in the same address count (in a second selection group = partial selection) retrieve
households in the "45 years and older" age groups from a particular region and interested in "House and
home" This way you achieve a quite individual selection of your target groups.
You can call up 'Partial selection' via the menu item 'Current options » Selection groups'. A new dialogue
appears which gives you the possibility of adding additional selection groups (in which case no criteria are
already set for the group) or to copy an existing group with all its criteria, in order to modify them.
And you can of course delete these selection groups again. To do this, you must have activated the group you
want to delete, then call up the dialogue and use the "delete" menu item.
The selection group where you are at any one time is indicated (highlighted) by the tabs which are displayed
as soon as you put together a new group. The overview of all the criteria selected (at the bottom of the page)
refers only to the group which is currently active or marked.
If you are working with few target groups or do not need different characteristics, naturally only one selection
group is sufficient.
3.5.2 Limits
You can define a limit, i.e.: a maximum number of addresses. In this case, a random selection is made from
the overall number.
You can call up this function after an address count (in the price information) via the menu item 'Current
options » Limit number of addresses'.
3.5.3 Excluding previous selections
Each download you make is marked for you permanently and free of charge in our database. This way you
can exclude addresses you have already purchased from subsequent counts to avoid repetitions.
As a registered user, you can have all your previous downloads listed (if you have made any) via the menu
item 'Current options » Exclude previous orders' and click on all those you wish to exclude. Note: if you have
only just performed the download, it may take several minutes until it appears in the list.
This function can be called up after an address count (in the price information). So, first perform the address
count of your potential market and then narrow it down.
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3.6 Price information / price quotation
Immediately after the address count, clearly laid out price information is displayed with the numbers of
households which correspond to your selection criteria.
Here we are not talking about approximate figures but about precise numbers - what you see in the price
information will be exactly what you receive in the invoice.
You can then place your address count in the shopping cart and purchase immediately - within minutes you
will have the Excel file on your hard disk. Or you can save it in your watch list to revise it later. (Note: the
watch list can only be saved from one session to the next if you are registered).
In each household you will be supplied the name of the first person who meets your selection criteria. Part of
the complete postal address is the form of address, any title the addressee may have (academic title) and the
name. Besides this you receive the Community key (identifies locality, Local Authority Area, Administrative
District, Federal State) and a pre-prepared address line ("Sehr geehrte Frau Dr. Müller").
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